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1 Program Information

1.1 Why T*SOL®?

T*SOL® is a program for the design and simulation of solar thermal systems including hot water
preparation, the support of space heating and swimming pool heating.

The program allows the planner to investigate the influence of individual system components on
the operating behaviour of a solar thermal system. All system parameters can be quickly changed
via the user-friendly interface.

Simulation results can be evaluated in graph or table format, making T*SOL® an excellent tool for
planning a solar thermal system.

1.2 Whatis newin T*SOL 5.0?
The most important features:

e New graphic user interface. One window per vVariant

e New graphic results presentation: Die presentation of system schematics is optimized.

o Data bases: Favorites, tables, sorting and filtering of components

e Database update: New system types, systems and components regularly.

e Air collector systems

e New tank systems with integrated auxiliary heating

e We have switched from British to U.S. English.

e EnEV-Assistent: annual yield calculation according to EnEV (Energie-Einspar-Verordnung,
German act on energy savings)

e New climate data selection

1.3 System Features

1.3.1  Overview
e Simulation of solar thermal systems supporting domestic hot water and space heating over
any period of time up to one year

e Design (optimisation of collector array area and storage tank volume) of the system to reach
specific targets

e Influence of partial shading by the horizon and other objects (buildings, trees etc)
e Graphic and tabular entry of shade values

e Design Assistant with automatic system optimization

e Comprehensive component database

e Working on a number of system variants at any one time within a project is possible, making it
easy to compare systems

e Domestic hot water consumption profiles included in the calculations

e Bothradiator and under-floor heating can be included

Dr. Valentin EnergieSoftware GmbH page 7 of 80
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e Investigation of energy use, pollutant emissions and costs

e Calculation of standard evaluation values for solar thermal systems such as system efficiency,
solar fraction etc

e Detailed presentation of results in reports and graphics
e Economic efficiency calculation following simulation over a period of one year

e Online Help facility

1.3.2  System types

You can select a system from the most common system configurations for domestic hot wate and
heating support, and you can choose between indoor or outdoor swimming pools to the solar
cycle. Additionally, you can select from a number of large-scale solar systems.

The system components (collectors, boiler, storage tank, and also consumption profiles) are taken
from the database, respectively.

T*SOL® calculates both shade from the horizon and from objects close to the system. For the
objects, you can take account of seasonal variations in shading (e.g. trees with and without
leaves).

1.3.3  Simulation and Results
The calculation is based on the investigation of energy flows and provides yield prognoses
according to the hourly meteorological data provided.

T*SOL® calculates the energy produced by the solar system in the production of hot water and
space heating and the corresponding solar fraction.

The results are saved and can be presented in graph format or in a results overview (Summary
Report). The graph maps the course of energy and other values, over any given period, and can be
saved as a table in text format, so that the results can be copied into other programs for further
evaluation.

By varying individual system parameters, the optimal system configuration can be found.

1.3.4 Economic Efficiency Calculation
After running a simulation over a period of one year, you are able to carry out an economic
efficiency calculation for that variant.

Taking into account the system costs and any financial support (e.g. government grant), the
economic efficiency parameters, e.g. capital value, annuities and cost of heating, are calculated
and detailed in a report.

1.3.5 Comprehensive Database of Components
The program comes with a comprehensive database of the following components:

e Collectors
e Boilers
e Storage tanks

If you want to stay up to date, we would recommend a T*SOL® Service Agreement. You will then be
sent regular program updates and revised component database units.
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2 Installation

2.1 Hardware and Software Requirements

T*SOL® is a WINDOWS™ application. One of the following operating systems needs to be installed
on your computer before you can run the program: Windows ME, Windows NT, Windows 2000 or
Windows XP.

T*SOL® requires a minimum of 256 MB RAM. With less memory there is no guarantee that the
program will run.

Recommended system configuration:
500 MHz Pentium PC
256 MB RAM
400 MB hard disk drive
VGA colour monitor
CD drive

The fully installed program uses approximately 120 MB of hard disk space. Each additional
weather data file requires 5 MB. You will require approximately 220 MB of free hard disk space in
order to run T*SOL® comfortably, complete with all available weather data. Please ensure that you
have enough space free on the hard disk before you install the program.

In order to run T*SOL® you must have the full licence rights (full access) to the T*SOL® installation
folder.

The formats for currency, numbering, time and date that are defined within the country settings of
Windows* system control on your computer are automatically reproduced within T*SOL®. These
formats also appear in any T*SOL® documents that you print out. In order to run the program, it is
important that the symbols separating thousands and decimals are different.

You should set your monitor display to Small Fontsvia the Windows system control.

2.2 Program Installation
Please close all programs before commencing the installation procedure.

To install the program put the program CD into your computer’s CD drive. The installation program
will start automatically and you will be taken through the installation procedure step by step
(unless the CD drive autorun function has been deactivated on your computer).

If the autorun function has been deactivated, you will need to start the “Setup.exe” file which is
on the CD. To do this you can start File Manager or Explorer and double click on the “Setup.exe”
file in the CD drive.

If you install T*SOL onto a computer with WinNT, WIN2oo0o or WinXP, you will need to have
administrator access to the operating system.
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To run the program, you will need to have full rights (read and write) to the T*SOL program
directory (e.g. C:\Program Files\Valentin EnergieSoftware\TSOL).

2.3 Program Activation

After installing and opening the program, a small window appears asking whether you wish to
start the program as a Demo Version or register the Full Program. This dialog appears until you
have activated the program successfully.

HC b

Welocomel

Waltome - you cas srw acbvsis your programims.

Thés invalves the Telswey steps) Foress
1. EdlEF fpwinl il Carsosl
2. Frogramssen 1D iv allzcabad

E. egwest ey Code

4. Emitur koy code Helo 7

Program Activation is carried out by entering a Key Code. The Key Code is provided by the
program manufacturer on request.

First you will need to make sure that:
e You have a Serial Number
e The program has already been installed
e When you start the program, you click on the “License Full Version” button.
Program Activation is carried out in four steps: Activation
e Enter Serial Number
e Notify allocated program ID by e-mail, fax or telephone

e Receive Key Code

e Enter Key Code

2.3.1  Enter the Serial Number

If you purchased the program from us, you will already have a Serial Number. You will find this on
the CD case, on the invoice or we have sent it to you by e-mail. The Serial Number has the
following format:

30138-012P-250-CHWD-1-EHB8-PH-CEPR-AGU

It needs to be entered exactly as it appears, without any spaces. After the Serial Number has been
entered, the program allocates a Program ID, which is based on the Serial Number and a code for
your PC.
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Enter Serial Mumber
L. 7 zens Hunber [RTIOITETR-CINT-LDRR-FI-CIFA-AGL | | o
R S— (i

You Still Don’t Have a Serial Number?

This could be the case if, for example, you have installed the program from the Demo CD or you
have downloaded it from the internet. You will need to purchase a full version of the program
before you can receive a Serial Number.

Send us the Order Form which you can print within the program under “Info/Registration”, or you
can purchase the program direct from our website.

You’ve Purchased the Program and Can’t Find Your Serial Number?

No problem. Send us the invoice for the program with your contact details and we will send you
the Serial Number again.

2.3.2 Request a Key Code

After entering the Serial Number and automatic allocation of the Program ID, you will need to
provide us with this information, so that we can send you your Key Code. You will see the
following window on your screen:

Exter Gorial Humber

1. 7 swsmnber [RHGeTRCmeBemorRaG] | oK |
R =)

Ergaes Key Code
Fmpieh st by

3. ? [om | [iwa | [ Fa | [ oo |

Edler Koy Cads
8 ? | ] =] [ Caed |

You can request the Key Code in three different ways.

2.3.3 Request a Key Code Online
This method requires that your computer has internet access.
Click on the “Online” button underneath “Program ID” in the Registration window. A form opens in

which you enter the data required to obtain a Key Code. The fields marked: * have to be completed
to continue.

After completing the form, you can send it straight off — the recipient’s address is entered
automatically. After sending, you will receive the Key Code by return (allow up to 20 minutes for
this). It will be sent to the e-mail address entered on the form.
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2.3.4 Request a Key Code by Fax

If you click on the “Fax“ button underneath “Program ID” in the Registration window, a form opens
for you to complete and print off. Send the completed form by fax to: +49 30 588 439 11.

You will then receive the Key Code by fax within one working day. You can also enter an e-mail
address to which the Key Code should be sent.

2.3.5 Request a Key Code by Telephone

If you do not have a fax or an e-mail address, you can request a Key Code by telephone. In this
case, you will need to give your Program ID over the phone.

2.3.6 Enter the Key Code

Once you receive the Key Code, you will need to enter it by hand or copy and paste it into the field
under “Enter Key Code” in the Registration window and then click on the “OK” button. This
completes the program registration and activation procedure.

An information window appears with a message that registration has been completed and the
program is now fully functional.

Information pd

@ Your programme is now activated,

_* The logo illustrated here will be used as the program icon. After installation it will appear
= in the Windows Start menu.

The single licence version of T*SOL® can only be installed locally. However, since the database
and project files can be saved to any file paths required and these can then be set in the program
as the standard file paths, it is therefore possible to move parts of the program to other hard
drives.

If you wish to install the whole program onto a network, you will require the network version of
T*SOL®,
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3 Introduction

3.1 Functional Basics

With the increasing use of thermal insulation in buildings and the resulting reduction in heating
energy requirements, the share of energy required for heating water in a building's total energy
requirement is growing in significance.

Thermal solar systems can cover a considerable portion of this energy requirement. Current
systems for solar water heating function highly reliably and enable annual energy yields of 350 to
500 kilowatt hours per m2 of collector area. At the same time, they cut the emission of c. 100-150
kg of the greenhouse gas CO2. Solar thermal systems directly use the sun's radiation and convert
it into heat on an absorbing surface, which is particularly of use in the field of hot water supply.

A thermal solar system must carry out the following tasks:

¢ Conversion of the sun's irradiated energy into heat with the use of collectors
¢ Heat transfer to the storage tank via the piping system

¢ Storage of heat in buffer tanks until required by the user.

In the process, energy is lost at the collector, in the piping system, and in the storage tank.
Minimising these energy losses is the job of practical adaptation and planning of the solar system
for each specific scenario.

The system efficiency serves to evaluate these losses. It is defined as the ratio of available energy
from the solar system to the irradiated energy onto the collector area. The share of total energy
available covered by solar power is termed the solar fraction.

3.1.1  Basic Construction of a Solar System

The key component of a solar thermal system is the collectoror the absorber, which converts solar
energy into heat and transports it by means of a heat transfer medium via piping systems and
heat exchangers to a storage tank. In systems for hot water supply, the storage tank compensates
for fluctuations in energy supplies and requirements at varying times of the day. In large solar
systems which also greatly contribute to heating energy supplies, an underground seasonal
storage tank is usually constructed in a local heating system to compensate for seasonal
variations in irradiation and energy demand. These seasonal supply systems are currently at the
trial stage and will not be considered further here. Where the solar energy is insufficient, an
auxiliary heating system supplies the outstanding amount of energy to cover requirements.

A controller monitors the operational state of the solar system and ensures the most efficient use
of the energy irradiated. If there is a temperature difference between the storage tank and the
collector, it switches on the circulation pump in the collector loop, ensuring heat transport to the
storage tank.

3.1.2 How the Absorber and Collector Work

Black surfaces are particularly good at absorbing shortwave radiation of light and then converting
it into heat. This physical property is used in the so-called absorbers. These are made from plastic
or metal in the form of panels, mats, or pipes with a black surface which, depending on the quality
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of the absorber, is voltaic or otherwise finished. Absorbers are the active part of a solar system.
Depending on the scenario and the level of the required temperature, a distinction is made
between

¢ absorber systems and
e collector systems.

Absorber systems are not insulated or covered. The heat transfer medium flows directly through
them. These are structurally simple, affordable systems suitable for operating temperatures
below 40° C. Their primary areas of application are heating swimming pool water and preheating
service water.

Absorber mats, usually made from plastic, can be placed on flat or slightly inclined roofs, also
retrospectively, with little construction work.

Collector systems with flat plate collectors contain an absorber (typically in metal) in a sealed
housing fitted with a transparent cover and heat insulation on the rear side. The transparent
covering reduces irradiation from the absorber to the environment, while the thermal insulation
reduces heat losses on the rear side, enabling temperatures of over 150° C to be reached. Primary
areas of use are in water heating and space heating. Flat plate collectors are available in various
sizes from 1 to 10 m2. Special designs (e.g. triangular) are also possible. They are integrated
within the roof cladding in prefabricated modules or attached to the roof cladding and
interconnected.

Evacuated tube collectors contain a metal absorber sealed in evacuated glass tubes. The vacuum
ensures that heat losses are kept to a minimum, enabling temperatures of over 200° C to be
reached. Areas of use are heating service water, space heating, and generating process heat, as
well as solar cooling of buildings.

3.1.3 Task of the Storage Tank

As in all hot water systems, the storage tank's task is to balance peak demand and charging
power in supplying hot water and in solar systems additionally compensates for time differences
between solar energy supply and hot water requirements. It typically features a heat exchanger at
the bottom, in which the transfer medium from the collector (usually a water-antifreeze mixture)
transfers the solar energy from the collector to the storage tank's content.

Where required, the upper part of the storage tank is additionally heated by a conventional
heating system, so that the hot water taken from the upper part is always at the required target
temperature, irrespective of available solar energy. Larger solar systems use several storage
tanks connected in series, of which the last one is used for reheating.

3.1.4 How the Controller Works

Solar systems principally use a so-called differential temperature controller. This control principle
compares the temperatures at the absorber and in the storage tank. If the absorber temperature is
a preset level above that of the storage tank, the circulation pump in the collector loop is switched
on. The irradiation energy converted to heat in the absorber system is transported to the storage
tank, whose temperature increases. When the temperature of the storage tank is equal to that of
the absorber, no more energy can be supplied to the storage tank and the pump is switched off.
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3.1.5  Design of a Solar System

Small systems in detached private homes are typically designed such that they largely reach a full
supply outside the heating periods, so that the boiler can be shut down in the summer. Around 60
% of annual hot water requirements can be covered by solar energy in this way. Larger solar
fractions, i.e. if a large proportion of water must be heated by solar energy in spring, autumn, or in
winter, give rise to a surplus in the summer which cannot be used. The solar system is then no
longer operating as effectively as possible. In other words, an increasing solar fraction reduces
the efficiency of a solar system. For systems in multiple dwellings or social institutions in which
the auxiliary heating cannot be switched off because of tenancy laws or other provisions, current
solar systems are designed with a solar fraction of up to 30 %.

There are no simple methods to calculate the yield of a solar system precisely. The number of
parameters which determine the performance of a system is too large, and includes not only the
changeable, non-linear characteristic of the weather but also the dynamic processes in the
system itself.

In larger systems, computer simulation is the only way to investigate the influences of ambient
conditions, user behaviour, and of various components on the operational state of the solar
system.

Solar systems can also be used for heating wherever heat is required in the summer or where
solar energy can be used for cooling in summer. A further use of solar systems for auxiliary
heating is in the field of low-energy houses. There, the fraction of heating energy occupies the
same order of magnitude as the hot water supply.

In buildings with current thermal insulation standards, designing solar systems with the option of
seasonal storage for heating purposes, also in winter, is inadvisable. This results in very large
collector areas and, at the time, high surplus energy in the summer, i.e. in systems with very poor
efficiency and consequently very high solar heat prices.

3.1.6  Economics of Solar Systems

Current solar systems are always bivalent, as they can never be solely responsible, at least not
year-round, for supplying heating energy. They are therefore connected upstream with
conventional systems and function as "fuel savers" by transporting more or less preheated water
to the downstream heating system.

To consider the economics of a solar thermal system, the investment costs are applied to the
lifetime of the system, taking into account simple interest and an amount for maintenance and
operating costs. In relation to the annual heating amounts supplied, this gives the heating price in
cents/kWh. The heating price for a kilowatt hour generated by solar energy is of the same order as
the generation of hot water from electrical current, now considerably lower for larger systems.

This development will also enable and intensify the use of solar thermal systems in medium-rise
housebuilds in the coming years. The money saved from the oncosts of burning fossil fuels is not
included here. However, the slightly higher heating energy bills are becoming accepted by many
tenants today as a result of an improved social image and a considerable improvement to
residential surroundings with the visibly ecological "advertisement".
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3.2 Calculation Basics

3.2.1  General Design Notes

There are no simple methods to calculate the yield of a solar system precisely. The number of
parameters which determine the performance of a system is too large, and includes not only the
changeable, non-linear characteristic of the weather but also the dynamic processes in the
system itself.

Although there are rules of thumb, such as around 1-2 m2 of collector area per person and 50 |
storage content per m2 collector area, these apply at best for small systems in detached or semi-
detached houses. In larger systems, computer simulation is the only way to investigate the
influences of ambient conditions, user behaviour, and various components on the operational
state of the solar system.

Solar systems can primarily be used for heating purposes where heating is also required in the
summer. These systems can then also make an appreciable contribution to building heating in the
spring and autumn. In buildings with current thermal insulation standards, designing solar
systems with the option of seasonal storage for heating purposes, also in winter, is inadvisable.
This results in very large collector areas and, at the time, high surplus energy in the summer, i.e.
in systems with very poor efficiency and consequently very high solar heat prices.

To design or optimize a solar system with T*SOL®, the following steps must be followed:

3.2.2 Energy Balance
A thermal energy balance is generated to calculate status and temperature changes during a
simulation period. Mathematically, this means the numerical solution of a differential equation.

Total of allinput and output energy
Total of all heat capacity

Change in temperature =

Balancing means that the total of all input energy, output energy, and storage of energy via the
heat capacity of the system components must be equal to zero. This balancing is not carried out
wholesale for the entire system but for the individual system components.

Collector

Collector loop

e Heat exchanger

e Unlimited layers in storage tanks with stratification

For each of these components, the change in temperature is calculated with the above formula on
the basis of energy input and output and the heat capacity of the respective component.

Energy inputcan be (depending on the component):

e Irradiation,

e Heat supply to the heat exchanger,

e Heat transfer by mass flow due to consumption or circulation,
e Intermixture of storage tank layers.

Energy outputcan be:

e Heat losses by radiation from the collector (quadratic transmission coefficient),
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e Heat losses at the insulation of the collector, the piping (collector loop or circulation), the
valves, or the storage tanks,

e Heat transfer to the heat exchanger,

e Heat transfer by mass flow due to consumption or circulation,

e Intermixture of storage tank layers.

The heat capacities of the following components are taken into account:

e Collector
e Piping of the collector loop
e Storage tank content

3.2.3 lIrradiation Processor

In the supplied climate files, irradiation to the horizontal plane is given in watts per square metre
of active solar surface. The program converts this to the tilted surface during the simulation and
multiplies it by the total active solar surface.

Here, the radiation must be split into diffuse and direct radiation. The splitting is carried out
according to Reindl's radiation model with reduced correlation. [Reindl, D.T.; Beckmann, W. A.;
Duffie, J.A. : Diffuse fraction correlations; Solar Energy; Vol. 45; No. 1, S.1.7; Pergamon Press;
1990]

These are then converted into irradiation on the tilted surface, using the anisotropic sky model by
Hay and Davis. [Duffie,).A.; Beckmann, W.A.: Solar engineering of thermal process; John Wiley &
Sons, USA; second editions; 1991]

This model takes into account the anisotropy factor for circumsolar radiation and the ground
reflection factor (= 0.2).

Irradiation on the collector area (active solar surface) is calculated from the radiation strength
(W/m2) on the horizontal plane:

the height of the sun and the solar azimuth is determined on the basis of the date, time, and
latitude.

On the basis of the height of the sun, the solar azimuth angle, the collector tilt angle, and the
collector azimuth angle, the position of the sun relative to the collector surface is calculated. This
allows conversion of the direct share of solar radiation on the horizontal plane into the direct
share of solar radiation to the collector, taking into account the active solar surface. The position
of the sun relative to the collector surface is also required when calculating the reflected
irradiation (see incident angle modifiers in the collector equation).

3.2.4 Consumption of Primary Energy
Consumption values, efficiencies, solar fractions, and other parameters can be calculated from
the temperatures and the energy flows of the system.

The use of fuels by energy type (natural gas, oil, wood pellets, district heating) is calculated from
the energy transferred to the auxiliary heating at the heat exchanger via the heat equivalent and
the efficiency of the auxiliary heating. The efficiency of the auxiliary heating is determined
depending on the return flow temperature, enabling simulation of the various efficiency levels at
different capacity utilisation of the heating system.
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3.2.5 Calculation of CO2. Emissions

The CO: emissions saved by the solar system are calculated in the results summary. For this, it is
necessary to know which type of primary energy is saved by the solar system. Emissions factors
by fuel type are used to calculate the CO- emissions of a heating system. The following emissions
factors are used in T*SOL®:

Fuel Heating value Egmcigszi(;lr(l]s
0il 36722 kJ/I 7,32748
Gas 41100 kJ/m3 5,14355
District 5,14355
heating

Wood pellet 15490 kJ/kg CO2-neutral

Table 3.1 Heating values and emissions factors

3.2.6 Efficiency and Solar Fraction
The collector loop efficiency is defined as follows:
Energy output fromthecollector loop

. viatheheat exchanger
Collector loop efficiency =

Energyirradiatedontothecollector area
(active solar surface)

The system efficiency is defined as follows:

Energyoutput fromthesolar system

Systemefficiency = bt Mt b
Energyirradiation ontothecollector area

(active solar surface)

The energy output by the solar system consists of the energy transferred from the solar storage
tank (as a result of consumption and, where applicable, a recirculation system controlled in the
solar storage tank) to the standby tank. As there is no difference between the solar and standby
tanks in some systems (single storage tank model, e.g. bivalent storage tank or reheated buffer
tank), the system efficiency of these cannot be calculated. The storage losses are therefore at the
expense of reheating.

The solar fraction is defined as follows:

Energy suppliedto thestandby tank

. fromthesolar system
Solar fraction=

Totalenergy suppliedtothestandby tank
(Solar system+auxiliary heating)
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The following applies to a solar system with bivalent storage tank (internal heat exchanger) for
water heating and auxiliary heating:

Qkww + QSHzg
Qxww + QsHzg + Qzww + QzHzg

solar fraction, total =

Qxww

Solar fraction,hot water =—————
Qxww + Qzww

QSHzg

Solar fraction, heating=————
QSHzg+QZHzg

The calculation for a solar system with a combined storage tank is as follows:

Legend:
. K
Solar fraction, total = Q ¢ Collector loop
Qx+Qzww +QzHzg A Auxiliary heating
Qk — QsHzg S Solaryield as per the

Solar fraction,hot water = storage tank (net)

Qx — QsHzg + Qzww
HL Heating loop

Solar fraction, heating =& DHW

QsHzg + QzHzg

Damectic hat water (including

Dr. Valentin EnergieSoftware GmbH
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The energy supply for heating drinking water is the energy required to heat the cold water to the
temperature of hot tap water. Losses from the storage tank or the circulation are not included
here.

The fuel used is the amount of fuel required to reheat the standby tank / the standby part of the
storage tank to the target temperature. Heat losses from the storage tank and the boiler
efficiency are included here.

3.2.7 Storage Tank Model and Operation

The stratified storage tank model uses storage layers of varying thickness, i.e. also of varying
volume, whose number can vary depending on the operational state. The number of layers is not
set, rather new layers are formed and the layer thickness is changed during the course of the
simulation. This takes place via the feed-in and feed-out of volumes of water and the intermixture
of temperature layers if the temperature stratification is reversed. The minimum layer thickness is
defined by two system definitions: a layer cannot contain less than 1 % of the overall storage
volume, and a temperature difference must be present between the layers.

3.2.8 Feed-In and Feed-Out

The cold water intake is always in the lowest storage tank layer, hot water is generally drawn from
the highest layer. The inlets and outlets of the internal heat exchanger are set by the selected
storage tank and are correctly represented in the storage tank view in the T*SOL® interface, as are
the levels of the temperature sensor to control the collector loop and auxiliary heating.

3.3 Economics Calculation
The economics calculation in T*SOL®, according to the pay-off method, is based on the following
formulae:

Capital expenditure = systemcosts —subsidies
Annualoperating costs = pump capacity *lifetime *electricity costs

The cash value (CV) of a price-dynamic payment sequence Z, Z*r, Z*r2 ... over T years (lifetime) as
per VDI 2067 is:

Cashvalue CV=Z*b(T,q,r)

1-(r/q)
q-r
T/lq fir r=gq

Cash value factor H(T,q,r) = fiirr<>¢q

g: Simple interest factor (e.g. 1.08 at 8 % simple interest)
r:  Price change factor (e.g. 1.1 at 10 % price change)

The following applies for the capital value of the total investment:
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Capital value of the totalinvestment

= Z[CV of price-dynamic payment sequencesover thelifetime]
—Investments
+Subsidies

The pay-back time is the period the system must operate for the investment to yield a cash value
of zero. Pay-back times of over 40 years are not supported.

To calculating the heating price, the cash value of the costs is determined:

CV of costs =investment + CV of operating and maintenance costs

If the CV of the costs is converted into a constant sequence of payment (r = 1), then the following
applies to this sequence Z:

Z= CVofcosts/kT,q,r)

Forr=1, 1/b(T, q,r) to the annuity factor a(q,T) =q* (q—1)/(qT —1) (again as per VDI 2067).

The heating price is then:

Heatingprice= Annualcosts Z| Annualenergyyield

Dr. Valentin EnergieSoftware GmbH page 21 of 80



3 Introduction T*SOL Manual

3.4 Swimming Pool Calculation
The swimming pool is calculated as a 1-layer storage tank, including the following gains and
losses:

e Evaporation losses at the surface

e Convection losses at the surface

e Transmission losses at the pool wall

e Irradiation gains at the surface

e Reflection losses at the surface

e Heatradiation at the surface

e Fresh water intake as a result of evaporation, pool discharge, and filter cleaning

The swimming pool heating requirement - to the extent that auxiliary heating is available - is
defined as the total energy transferred from the solar system and the auxiliary heating to the
swimming pool. Using the swimming pool heating requirement, the solar fraction of the swimming
pool is derived.

There is the possibility that the target temperature cannot be reached in pools without auxiliary
heating. As a result, the swimming pool heating requirement cannot be determined from the
simulation. In this case, the swimming pool fraction is defined as the percentage of time in which
the swimming temperature is above the target temperature to the total operating time.

A fraction of 100 % means that the pool temperature was reached or exceeded over the entire
operating time. As the pool can also heat from irradiation and warm ambient temperature without
the solar system or auxiliary heating, this also results in a positive solar fraction.

The swimming pool and - where auxiliary heating is available - swimming pool heating
requirement fraction are shown in the project report.
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4 Brief Instructions

The aim of this section is to introduce the user to the scope of the T*SOL® program, drawing on
the most important and most frequent questions raised by users. The planning and design of a
solar thermal system using T*SOL® will be illustrated using the menus and following the various
steps that need to be carried out, in their recommended order. The corresponding speed button
symbols for direct access to the dialogs will be shown.

4.1 General Information on Design

There is no simple method of calculation which can be used to exactly determine the yields for a
solar system. The number of parameters required to determine the operating behaviour of a
system is too large. This is not only affected by the changeable, non-linear behaviour of the
weather, but also by the dynamic nature of the system itself.

Of course there are rules of thumb such as 1-2 m2 collector surface per person and 5o litre storage
tank capacity per m2 of collector surface, but these are only valid, if at all, for small systems
serving one or two households. Only calculation-based simulation makes it possible to
investigate larger systems in respect of the influence of the surrounding conditions, consumption
variations and different components on the operating conditions of the solar system.

Solar systems can be used for heating purposes, above all, in areas where heating is also
required in summer. These systems will then, even during the transitional period, make a
considerable contribution to heating the building. However, something that should be avoided at
all costs is the design of a solar system for heating without the possibility of seasonal storage,
even in winter. This would lead to extremely large collector surfaces and at the same time excess
energy in summer, i.e. to systems with very poor efficiency and therefore very high heating costs!

In order to design and optimize a solar system with T*SOL®, the following steps should be
followed:

4.2 Enter Site Data

Site Data are characteristics of the project, which don’t change with the variant, i.e. data on
climate, building, hot water consumption, heating demand, process heating, or such. Therefore,
they menu Site Data is to be found in the main menu bar.

Database Options |

Climate
Buildi
oo Figure 4.2.1:

Hot water consumption Site Data menu
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Construction Dialog

4.3 Set Up a New Project

| Bu\\d\ngl Plannell Project F‘anipall

Project Name IPm|ect3

Project Folder [Frcicois

[Pre-Set Data for ‘weather Diata Record for "New Variant"

‘weather Data Record Berlinwhy Select

Location: |Berlin

Hotes

e Figure 4.3.1:

Data entry dialog for setting up a
new project

To set up a new project you will need to open the General Project Data dialog and enter at least
the reference or name of the project. This will also serve as the name of the project folder, into
which the project ‘variants’ worked on in the course of the project should be saved. All other

details can be entered at a later date, as and when required.
Exit the dialog with OK to set up the project. You can then define and work on as many project
variants as you wish.
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Figure 4.4.1:
Design Assistant

If you do not have a firm idea of the design of your solar system yet, you might use the Design
Assistant to size your system, rather than manually entering every time.

The Design Assistant is available using the default setting region = Europe, only

The Design Assistant leads you through all the necessary stages, including the selection of a

suitable collector and storage tank. These components are determined, after entry of the target
solar fraction (i.e. the annual solar contribution percentage), by the calculation results of a mini
simulation.

By clicking on the Accept button, the parameters entered and determined in the Design Assistant
are transferred into the system.

Dr. Valentin EnergieSoftware GmbH
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4.5 Select a System @]

=]

£ Showll £ HotWaler, Healing
T Hot Water

g - g - g <
F A A
’ M I;ll F ’H, I~
L [y [ gy
F_5 4
L) "ﬁ l 5
a - ’
H l =" ’ = b
ol L.y P .y
Figure 4.5.1:
Systems Selection
o | _== | | Dialog

If you already know which system components you want to use, you can select these directly from
the System » Select menu. This gives you an overview of all of the component combinations
available with your version of the program.

Select the system you want to use by double clicking on the image or on the list entry. The system
will take on the parameters of the currently active project variant. You can view the selection as
icons orin a list.

4.6 Enter System Parameters
This menu allows you to enter or change your solar system’s component parameters.

Collector Array [ x]

Parameters | \nc\inationl Piping |

Number of Callectars: |5 Gross Suface Area: 5 e

Active Solar Surface: 5

i Collector
Manufacturer.  T*S0L Database
Type: Standard Flat-Flate

Feference: Flat-Plate Collector arameters

Shade

Select |
—— oK
_Femor | Figure 4.6.1:

— == |l pata entry dialog for system components - e.g.
=B coltector array

Shade

A number of parameter dialogs are displayed, onto which all the necessary data is entered. Use
the red arrow buttons in the bottom corner to move between each component’s dialog window.
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Another possibility for entering the parameters is via the Main Dialog. In the Main Dialog
you can also use the red arrow buttons to move between the component dialog windows.
You should also note that there may be a number of tabs for each component.

A quick way of reaching the individual parameters for the individual components is via the system
schematic. Just position the mouse arrow over one of the components and double click or click
with the right mouse key to get to the corresponding dialog (characteristics).

i The Basic Data in respect of the climatic conditions and the hot water and
| "y heating requirements for the actual variant can be modified via the
corresponding buttons allocated.

3

4.7 Set Up a New Variant

Variant Reference

Wariant Reference:

[Variant2

“fou have a number of options to design a new Variant

LCancel
€ Always use default system

¢ Duplicats Existing Yariant

% Selection of Mew System Hydraulics
™ Selection of Mew Systemn Hydraulics with Current Yalues

¢ Dpen T"S0L Design Assistant Figure 4.7.1:
Data entry dialog for setting up a new variant

Within each named project you have the possibility of setting up as many variants as you wish,
each containing different systems and components. You can open and work on up to six variants
at any one time. The variants allow easy comparison of parameter choices while keeping the filing
simple.

There are a number of options for setting up a new variant.

4.8 Simulation

Simulation Period [ x]

[~ Simulation Period

o whole vear b

-

Start: |1 1. End: |3112

Recording Interval: |1 Day =

Pewn [ [Das 7]
Figure 4.8.1:
el | Data entry dialog for simulation parameters

The size of the simulation interval sample varies between one and six minutes. What is decisive
here is the system inertia resulting from the capacities and energy flows.

For the evaluation of the simulation results, it is often enough to work with values resulting from
larger simulation intervals (hourly or daily).

Use the speed button at the top of the screen or the pull down menu to carry out a
simulation for the project variant that is currently active.
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If you go to the simulation dialog via the pull down Calculations menu, you are able to select the
simulation period and the recording interval. Depending on the selected simulation period, a
number of different recording intervals are offered.

o Clicking on the View button allows temperature conditions to be observed graphically
during the simulation. The exact time of each simulation step is shown in the status bar for
the variant in the bottom left corner.

At the end of the simulation a selection dialog opens so that you can view the results (report or
graphics) or carry out an economic efficiency calculation.

4.9 Economic Efficiency Calculation

Economic Efficiency Calculation Entiy Parameters
Parameters | Inveslmentl FRunring Costsl Savingsl Loan |
Lite Span: lZ[I— ‘ears
Interest on Capital: [4 %
Price Inciease Rate
Energy: [ %
Running Costs: [0 %
Load Standard Values |
Figure 4.9.1:
Net Present Value: -3.578€  Cost of Solar Energy: 0,20 £/kWh ) ) .
Data entry dialog for economic efficiency
OF E conomic Efficiency Calculation Cancel H
[ox ] =) Y —ted || calculation

In order to carry out an economic efficiency calculation, the results of a simulation carried out over
a period of one year must be available.

Click on the button, or access the dialog via the Calculations » Economic Efficiency menu.
E The parameters required to carry out an economic efficiency calculation are initially taken

from the Options » Default Settings menu, which can be changed as required for the design
of special systems. The simulation results are combined with the Site Data to carry out the
calculations.

You are able to enter different values for each respective variant. If the changed values are to be
used in the simulation results, a warning will appear before saving.

The following values are entered onto the Parameters worksheet (each worksheet is indicated by
a dialog tab):

The Lifespanis the period given by the manufacturer as being the estimated operating life of a
system. For the majority of solar systems this is between 10 to 20 years.

The /nterest on Capitalis the interest rate at which the capital for the investment is borrowed from
a bank, or the interest that might be charged on the capital used.

The Price Increase Rates of the Running Costs and Energy (fuel costs) are important in calculating
the Net Present Value.

Changes can be made to the Investment worksheet as follows:
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The /nvestmentcan be entered as an absolute amount and as a specific investment cost in €/m?2 of
collector surface area.

The Subsidy can be entered as an absolute amount, as a percentage of the investment and as a
specific subsidy in €/m2 of collector surface area. (Note: the currency used for the calculations in
the program is dependent on the currency setting on your computer.)

The Running Costs worksheet includes the following parameters:

The Ffixed Running Costs of the system can be entered as an annual amount or as a percentage of
the investment in percent per annum.

The Pump Running Costs are the product of the running time produced by the simulation, the
pump performance and the specific electricity costs.

From the Savings worksheet it is possible to change the Specific Fuel Price adopted from the
Options » Site Data menu, if you want to design a special system.

By changing the values produced by the simulation for the So/ar Yield and the Fuel Savings (the
program will warn you before the changes are saved), you can for example determine at which
values the system would be economically viable.

On the Loan worksheet up to three loans can be defined:
The Loan Capitalis the amount of credit that is taken out.
The 7ermis the amount of years in which the loan has to be repaid.

In addition, either the Annual Installmentor the Loan Interest Rate has to be entered. In each case
the other field is blocked and calculated by the program.

The annual installment is the fixed annual amount with which the loan and interest are repaid over
the agreed term.

The loan interest rate is the percentage of interest that has to be paid on the loan. If the loan
interest rate if less than the capital interest rate, the loan takes on the function of a subsidy; if it is
more, the total costs increase. With identical interest rates they remain the same.

Finally, one all the data has been entered, the Economic Efficiency Calculation provides figures for
the Net Present Value of the system and the Cost of Solar Energy.
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4.10 Evaluate Results
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Figure 4.10.1:
Simulation results graph

T*SOL® offers you a two ways of evaluating the simulation results: graphical display and the
Summary Report.

The graphical display allows you to select up to eight curves. A graphics window appears

t: with its own menu, so that you can format the graphs as you wish. You can change the
break-down of the values, the display interval (from 1 day up to 1 year), font type and style,
colour and presentation (line graph or bar chart) of the curves and the guide lines.

The axes can be redefined and the graphic can be given a title. The values can be copied and
pasted into other programs for further evaluation.

The Summary Report consists of a three-page overview including the system schematic,
@, the entry data and the simulation results. The summary report can be printed via the page
preview.
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4.11 Options — Defaults — Regions & Units

4.11.1  Options — Defaults — Regions

Deetpult setmings &

'Miml Project rapart | Clvate dats renzrd | Cwnign ezsstent | Urda | Intered updets Lscslaaiaon

[ sy Bt

Apganad srittings Har 1 Armsrice -
: Figure 4.11.1:
1 Lige tighes haing vile Y], Hs 7 ke ey hding e [LHR, HE . .
Options » Default settings »

et e i st ol Localization: Select a region

T*SOL offers a regionalized version for the U.S. market, i.e., having set the option Region = U.S.,
the program offers not only u.s. units, but U.S. components, offered for sale in North America,
only. Select the region Europe, if you wish to use components available there.

I The Design Assistant is available using the default setting region = Europe, only

4.11.2 Options — Defaults — Unit Systems

Detpilt etmings i
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Figure 4.11.2:

17415 unds
Unit system selection dialog

e o, L i, = g i e, | el p e IR s, it .

You can have result values displayed in different units in diagrams or project reports. Select

between:
User-defined units: While the T*SOL default units usually garantee a good display, you
may use the button defineto chanage individual units.

Sl units: All units are displayed according to the international units system. Some values
might be presented in unusual low or high numbers.
US units: All units are displayed in U.S. units. This is for lengths, temperatures, and

energies.
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Group

Abbreviation

Unit selection

Time

Time

s, min, h,d, a

Energy and Power

Thermal energy

J, k), MJ, Wh, kWh, MWh, Btu, kBtu, MBtu

Electrical energy

J, kJ, M), Wh, kWh, MWh, Btu, kBtu, MBtu

Thermal power

W, kW, MW, Btu/hr, kBtu/hr, MBtu/hr,
GBtu/h

Electrical power

W, kW, MW, Btu/hr, kBtu/hr, MBtu/hr,
GBtu/h

Reference energy

J, kWh, MWh, kBtu, MBtu

Dimensions Lenght mm, m, km, inch, ft, yd
Area m2, mmz2, km2, in2, sq.ft
Volume [, m3, cu.ft, gal
Temperature Temperature °C, °F
Temperature difference K, deg .F
Other units Volume flow l/h, l/min, |/s, gpm
Velocity m/s, ft/s
Weight kg, lbs
Inverse units 1/Ref. Energy kWh, kBtu
1/Area m2, sq.ft
1/Volume fluid |, sal
m3, gal

1/Volume solid

page 32 of 80

Dr. Valentin EnergieSoftware GmbH




T*SOL Manual 5 Calculation Examples

5 Calculation Examples

Read the following two project examples and at the same time carry out the individual steps in the
T*SOL® program.

You will find further project examples in the project folder, which is reached via the menu
== | File » Open Project or by clicking on the button.

5.1 Set up a New Project

Open Project 5'

"Project1"

-[- MNew Project

[& |  open Esisting Proect )
Projsks sellssling e Figure 5.1.1:

Project selection dialog.

When you start T*SOL®, the first dialog window will prompt you to select the project you want to
start with.

Click on the New Projectbutton in the dialog. If, however, you have already started T*SOL®, you

can reach the same stage via the File » New Project menu or by clicking on the button in the upper
button bar:

General Project Data x|

Project

Froject NamelExampIe

Project Folder IExampIe

—Set Data forweather Data Record for "New Yariant™

Weather Data Record: Augsburg why Select |

Location: IAugsburg

Motes

QK

Cancel

Figure 5.1.2:
General Project Data entry dialog.

The project name that you enter in the first field is saved as the file name for the project, so you
won’t have any trouble finding it later on. On this Project Data dialog worksheet, you are already
able to define a weather data record by clicking on Select. The selected weather data record will
then be automatically loaded within this project for each new variant selected.

Dr. Valentin EnergieSoftware GmbH page 33 of 80



5 Calculation Examples T*SOL Manual

After confirming the project data with OK; a standard system is loaded and the system screen for
Variant 1 appears with a diagram of the system.

From here you can start the Design Assistant by clicking on the button in the upper button
..a,: bar. The system schematic diagram is now of secondary importance.

5.2 Using the Design Assistant

| o T Pro Diesign asstann =t ] |
F Pepdert iy by
LN raae vanan | A Colecton
H S e nateay s rh.r[ |
|
r Chrade daty Eelaction W Tharg
aa

=

&
|i-—-- Figure 5.2.1:

Crnbinge o Camcel

/| Design Assistant, first sheet

The Design Assistant is there to help you establish the dimensions of a solar system. It should
therefore be used if you are not sure of the size of the collector array and/or the size of the
storage tank to be installed. The Design Assistant is an independent part of T*SOL® Professional
and the results it produces can be accepted into the main part of T*SOL® - the system screen.

! The Design Assistant is available using the default setting region = Europe, only
Project Example:

A renovated block of 6 flats in Augsburg, Germany requires a solar system for hot water
supply and the support of space heating. The building has a pitched roof with a 35 degree
inclination facing south east and an area of 40 m2.

Is this area large enough to provide the target 20% solar fraction of the total energy
consumption?

This question is most easily answered by using the Design Assistant.

You are able to use the Design Assistant at any time when working on an existing project —
a': either use the Calculations » Assistant menu, or (the faster option) click on the button in
the upper button bar. You can then select to replace the dimensions of the currently active
project variant with one of the sets of values calculated by the Design Assistant. If you want to
design a new variant, use the File » New variant menu and click on the command Open 7*SOL
Design Assistant.

For our calculation example, however, we want to design a new project, as the questions
regarding collector area and size of storage tank need to be answered right at the beginning of a
project.
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On the first sheet of the Design Assistant, you start by giving the planned solar system a name.
The word Variantis used, as it is possible to calculate a number of different system variants within
a project.

The weather data record for Augsburg has already been entered, as this was selected in the
General Project Data dialog. However, this can be changed by clicking on the button Weather.

Independent of the weather data record, the location of the building can also be entered, e.g. the
street address where the solar system will be installed.

In order to reach a result, we now have to go through the individual worksheets of the Design
Assistant, entering the information required. Use the buttons Continue, Back and Cancelat the
bottom of the dialog to do this. You can also click on the icons on the left of the dialog to access
the individual sheets direct.

5.2.1  System Selection

! wl TFL Pr Desigr astsn [ESRE=E )

Cr ket et 8 T iEal

Which amzreinns mookd you o io supply st salar gy ?

—
% B% (i Commschat waim

i

PAD Y

1
L 1]

L;._. Figure 5.2.2:

Design Assistant amenities
£ Back Condaae 2> Cancd .
| /| selection.

The next two sheets contain details on system selection. This depends on the planned use of the
system. You will have to select whether the system is to be used to supply hot water and/or space
heating. For the Project Example above, therefore, you should click on the circle to select Space
Heating.
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! wl TFL Pr Desigr astsn [ESRE=E )

Sl e SR

Sragl e Sterg Conabenaion D gpeten Buler pank cpstem
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i ¥ ' : 1!

¥

P DY

1
L=

Figure 5.2.3:
Design Assistant system types
£ Hark Conbage o> Canpcd .
| /| selection.

&
ha

Depending on the selections made on this worksheet, the following sheet offers a selection of
system configurations and types. The selection of the various systems is divided into small-scale,
combination tank and buffer tank systems. Click on the tabs to view the systems available under
each category.

To define the amount of collector area required, the Design Assistant makes use of a shortened
simulation procedure on an hourly basis. This procedure is restricted to the use of simple system
configurations. Design Assistant does not therefore contain all of the system configurations that
you can access from the system screen via the System » Select menu.

Back to our Project Example: the requirement is for a solar system to provide hot water and
support of space heating for a block of flats. We decide on the DHW System (2 tanks) with Space
Heating Buffer Tank (Small-Scale Systems — A4, three tank system) and click on the corresponding
diagram. This highlights the system and we click on Continue.
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5.2.2 Define Consumption

| f 150 Pro Desgn assisrant

[ e T T [

HOT wites Sasce-Tesing

Iyt fobwrber meormrent ewes

PNDY
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[r—\' Mgt 12 G2
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Figure 5.2.4:

L-— Definition of hot water requirement

< Back Contimenas Camped

| inthe Design Assistant.

Two worksheets need to be completed here: hot water and heating consumption.

You have a choice of two ways of entering the hot water consumption. If you know what the
average daily consumption will be, you can click on the circle and then enter the amount direct. If
you do not know, then you can enter the estimated or actual number of people that will be using
the system. A figure for the absolute consumption will then be calculated based on the number of
people via a pre-set specific consumption figure. The specific consumption per person can be
entered and changed from the system screen via the menu Options » Default Settings » Design
Assistant.

Our building contains 6 flats. If the calculation is based on 2.5 occupants per flat, this gives a
total figure of 15 occupants for the block (enter 15 in answer to the question No. of people to be
supplied?). As hot water secondary circulation is usual in many blocks of flats we should click on
the corresponding circle, so that circulation losses depending on total consumption will be
included in the calculation. The desired hot water temperature and the cold water temperature
should be entered here and can also be pre-set under Options.

Click on the tab labelled Space Heating to get to the worksheet for the space heating
requirements.

Our building has a floor space of 480 m2, which we enter as the area to be heated in the first entry
field. We also have the possibility here to enter the heating energy requirement (e.g. according to
DIN 4701) or, as this value is often not known, to let the program calculate it via internal codes,
after entering the building heating standard (this calculated value can then be seen from the
system screen). In our case we need to remove the tick (by clicking on it) for /s the space heating
energy requirement known?and then make the selections illustrated below.

To provide a figure for the annual space heating requirement, which T*SOL® calculates for every
hour of the year, you will need to enter the standard external temperature.
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5.2.3 Define Collector Array and Design Targets

! VAL P Design asstsant P .
}i‘ Sl ollecto peray
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Figure 5.2.5:

Definition of the collector array in the
: - “% || Design Assistant.

5 B

To start with, the Design Assistant uses the standard flat-plate collector from the T*SOL®
database. This corresponds to a simple collector with an area of 1 m2. You can, however, select
any collector of your choice from the database by clicking on the collector button or, from the
system screen, select your preferred standard collector under Options » Site Data.

The tilt angle and orientation of the collector array need to be entered next. The values for the
piping are based exclusively on the collector loop. The single length of piping should be entered.
The heating losses and hydraulic resistance of the piping are calculated from these values.

After clicking on the Continue button, the Design Target needs to be entered. In our Project
Example a solar fraction of 20% of the total energy consumption (hot water and space heating) is
required. We have selected natural gas as our fuel for auxiliary heating.

By clicking on Continue, we are provided with a selection of storage tanks that the Design
Assistant recommends for our system. Each of the recommended tanks can be changed by
opening the database and making a new selection. For each of the three buffer tanks
recommended, we can carry out a variation calculation by clicking on Variation.

page 38 of 80 Dr. Valentin EnergieSoftware GmbH



T*SOL Manual 5 Calculation Examples
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This takes you to a graph of the simulation results, showing the number of collectors required for
the three different buffer tank sizes. The collector number with which the target of a 20% solar
fraction is reached is shown by a white symbol.

It can clearly be seen that with a 1000 litre tank the target of a 20% total solar fraction will not be
reached. On the other hand, the difference between a 2000 litre and a 5000 litre tank is minimal.

The result is clearer still after clicking on Continue and the results are then shown in three bar
charts.

o TUROL Pro Design aststa Ler 2 b |
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L__‘ erel Jb i bl [0 1k 100 Figure 5.2.7:
- e Graphical display of simulation

results in the Design Assistant.

£ Bark » canps

Included in these charts, in addition to the solar fraction, is a further important evaluation figure,
the system efficiency. With an increase in the tank volume, the system efficiency increases and
the collector area reduces, with the solar fraction remaining constant.

Since in our Project Example a maximum roof area of 40 m2is available, the collector area even
with a large tank volume is too large to fit onto the roof. What can be done?

Let us try again with better quality collectors — evacuated tube collectors.
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We therefore click on the collector icon on the left hand side of the Design Assistant screen and
this takes us back to the collector selection sheet (Set Collector Array). There we click on Collector
and select the Standard Evacuated Tube collector from the T*SOL database, and otherwise change
nothing, and then click on the icon with the steps on the bottom left of the screen. The results are
now completely different.

With a much improved figure of 29% system efficiency, less than 30 collectors are required. We
decide on the variant with the 2000 litre tank and click on Accept info Projectto return to the
system schematic screen. The data that has been entered in the Design Assistant has been
transferred into the system on the system screen.

Back in the system screen it is now possible to carry out an immediate simulation (click on
the Start Simulation button), or to enter new or change existing parameters.

5.3 Configuring a Solar System via the Main Menus
Project Example:

A solar system for the supply of hot water is required for a newly built bungalow in Aachen. The
bungalow is to be home to a family of five.

e What size should the collector area be?

e At which tilt angle should the collectors be installed on the flat roof?

e How often does the temperature drop below 35 degrees centigrade in the storage tank?
e How much heating oil can we expect to save?

e  Which other measures should be taken into account when building the house?

The following additional details are provided with the house plans:

e The bungalow’s longitudinal axis is oriented from the south east to the north west.

e 240 m2floor space.

This type of solar system is frequently used for one and two family houses. As arule, pre-
configured systems are used here, as offered by many collector manufacturers. The configuration
of number of collectors, storage tank and other components should then be entered into T*SOL®.
For frequently used systems, you can save these as a standard project and then copy into a new
project as required and simply change the pre-set data, such as location, collector tilt angle and
orientation.

In this case, the calculations using T*SOL® mainly serve to determine the expected primary energy
savings, as well as the system’s solar fraction. An important result is also the proof that the
system is not oversized. When a system is oversized this is shown by the maximum tank
temperature frequently being reached, thus leading to high collector temperatures.
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5.3.1  Design a New Variant

Variant Reference

Yariant Reference:

ITypeA‘I|

“r'ou have a number of options to design a new Y ariant

= Always use default spstem

= Duplicate Existing Yariant

* Selection of Mew System Hydraulics

= Selection of Mew System Hydraulics with Current Values

= Open T*50L Design Assistant Figure 5.3.1:
Dialog for setting up a new variant.

We have already set up a project via the File > New Project menu (in this case it is the project
named “Examples”). For the above Project Example you will need to set up a new variant of
“Examples” via the File » New Variant menu. A dialog appears into which you can enter a Variant
Reference and in which you can select the method for design. We name our variant TYPE A1 and
select ...New System Hydraulics.

After confirming with OK; the Load System screen opens. The amount and types of systems
available for selection and simulation depends upon which of the T*SOL modules you have
installed on your computer (Standard, Swimming Pool, SysCat). You can change between icons of
the systems and a listing, in order to get an overview. We select the system labelled A1 and load it
into our variant with a double click, or a single click and a click on OK, and we are then back in the
system screen.

We now need to enter the specific parameters for the location, consumption and system
components into the system we have selected. There are a number of ways of doing this:

e individual components can be accessed via the menu commands of the System definition
menu;

e click on one of the components in the system schematic, to select the system component, and
then double click with the left mouse key to get to the component dialog (or click just above or
below the system to select the whole system, and then double click to get to the system
dialog) or click to select the component/system and then click with the right mouse key and
select Characteristics from the mini-menu;

e orclick on the main dialog button to access the main dialog directly.

i
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5.3.2 Define Parameters
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Figure 5.3.2: Variant menu > System
| | definition » Variant X
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For the complete definition of a system, as required in our example, it is best to go direct to the
Main System Dialog, as this will automatically take you through all the necessary dialogs. In the
main dialog you can use the red arrow buttons in the bottom right hand corner to move between
the various component dialogs.

In the Reference entry field of the first worksheet in the main dialog, you can enter a new variant
name, or amend an existing name. This reference, in this case Type A1, is the name that is shown
in T*SOL’s® blue title bar and is the reference under which you will be able to find the variant
again, eg in the Load Variant dialog. The weather data is also loaded here, the hot water
requirement is entered and the ambient temperature for the central boiler plant is defined. This
temperature is the reference temperature for the calculation of storage tank losses and secondary
circulation losses.

After loading the weather file for Aachen from the weather database for Germany (additional
weather data for other countries can be installed from the CD), we click on the red arrow to go to
the next dialog: Hot Water Consumption.

On the Parameters worksheet you enter the average daily consumption for the operating period
given on the Operating Times worksheet - usually the average daily consumption over a year. At
the same time, the total consumption for the operating period and the resulting energy
consumption are shown. The total consumption figure is dependent on the values entered under
Temperatures on the Parameters worksheet.

For our example of a bungalow in Aachen, we know that hot water is required for a family of 5. If
we assume a high standard, say 35 litres per person per day, we get to a total of 175 litres per day
at a temperature of 5o degrees centigrade. This daily consumption will not be spread out equally
over the day, but will be required at certain periods in differing volumes. This pattern of use is
illustrated in the Consumption Profiles. A number of different consumption profiles are available
for selection from the database and these can be loaded via the Selectbutton.

Click on the Parametersbutton to check and make changes to the consumption profile.
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Hot Water Consumption

Parameters | Elrculahnnl Operating Tlmesl

o Operating Times|
¢ Average Daily Consumption 175 |

€ Annual Consumption 53,88 e

Resulting Annual Energy Requirsment: 295359 kwh

~Temperature:
Desired Temp of Hot ‘water: ISD ‘C
Cold Water Temperature in February: IE T
Cold 'water Temperature in August: |1 2 ‘C
Load Profile [C ion Profile)
|
House [evening max.) Select

Cancel
[Pacnees | j Figure 5.3.3:

Hot Water Consumption dialog

Our bungalow will have a hot water secondary circulation system. You can take account of this by
selecting Secondary Circulation Available at the top of the Parameters worksheet (Hot Water
Consumption dialog). Once selected, a new worksheet will appear, labelled Circulation.

Hot Water Consumption E

Parameters  Circulation | Dperating Timesl

Simple Length of Piping Systam:lw 0 m

Temperature Difference - Flow/Return: |3 K

Specific Losses: |05 WA ek

Annual Circulation Losses: 1061.2 Kiwth
Resulting Wolumetric Flow Rate: 34,45 Ith

i Circulation Operating Time:
0 ¥ Al Days the Same
21 2
18 E
15 9 Fi
12 cncel || T'8UTE5.3.4:

- Secondary Circulation worksheet from the
—I* —I Hot Water Consumption dialog

On this worksheet, the circulation heat losses are calculated, based on the single length of piping
and the specific losses. By changing the temperature difference you can adjust the volumetric
flow rate resulting from the circulation pump. Click on the individual hours of the switching timer
to adjust the daily running times for the pump. Deselect A/l Days the Same to individually adjust
the daily running times for each day of the week.

On the final worksheet of this dialog, Operating Times, you can enter (independently from the
Consumption profile settings) breaks in the hot water supply, e.g. during holiday periods. During
the operating times that are deselected here, the consumption and circulation will be set at zero.

This completes the entries for hot water consumption and we click on the red arrow again to take
us forward to the Collector Loop Connection dialog. From here you can change the Volumetric
Flow Ratein the collector loop, as well as the mix of the heat conducting medium, eg in order to
simulate a low flow system. In this case, the volumetric flow rate in the collector loop would be
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between 10 and 20 |/m2/h. From the Control worksheet you can define the parameters for the
collector loop pump control, which is set according to specified temperature differences.

By clicking again on the red arrow, or on the Parameters button, you come to the Collector Array
dialog. In the Collectorsection of the Parameters worksheet, click on the Selectbutton to go to
the collector database, from which you can make a selection from the list of manufacturers and
collector types. In the header bar, there are drop-down lists of manufacturers and collector types,
which assist you in finding the product of your choice quickly and easily.
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Figure 5.3.5:
Collector selection dialog

Click on the preferred collector, or select and click on OK, to incorporate the collector into your
project design. Entering the number of collectors automatically gives the collector area. We
decide to start with 7 collectors with a total active solar surface of 7 m2. This is the active area that
is available to convert the sun’s radiation and which forms the basis of test institute calculations
to determine the collector coefficient.

On the Inclination worksheet you will find the parameters for the orientation and tilt angle of the
collector array. The Azimuth Angleis the horizontal deviation between the collector surface
vertical and the geographical south in the northern hemisphere (or the north in the southern
hemisphere). It is 0° when the surface is facing toward the sun’s highest point (zenith). In our
case the building is in the northern hemisphere and the building’s longitudinal axis runs from
south east towards the north west. If the collectors are also installed parallel to this axis, the
collector vertical (perpendicular to the active surface) points towards the south west. The azimuth
is, therefore, in our case the angle between the south and south west, that is +45 degrees.

As our example deals purely with hot water supply, we can install the collectors at a tilt angle to
gain the maximum possible irradiation. The absolute values for irradiation are given at the
bottom of the dialog. For a south west orientation, a tilt angle of 30 to 35 degrees results in
maximum irradiation values. For the time being, it is however more effective to select the steeper
angle. Thus you can answer the architects question regarding the tilt angle — 35 degrees from the
horizontal. At a later stage, we will be able to optimize this angle by carrying out a number of
simulations with different angles and then comparing the results.

In the case that you already have information regarding the length of piping from the water
heating system to the roof, the single length should be entered on the Piping worksheet. If this
value is not known, the pre-set values can be adopted.

Click on the red arrow to go to the next dialog, the Bivalent Domestic Hot Water Tank. As our
calculation will be based on hot water consumption of 175 litres, we select a storage tank of
double size, i.e. 350 litres, which you can load from the database by clicking on the Selectbutton.
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If you want to use a storage tank that is not included in the database, you are able to change the
tank volume after loading. The tank will then be saved in the project with the data as amended.

We do not need to make any further entries for the storage tank, and the Control settings also
remain unchanged. The pre-set value for the Desired Temperature of Tank of o K (Kelvin) on the
Control worksheet, means that the upper-tank temperature corresponds to the desired
temperature of hot water, which, in this case, we set at 50 °C.

A further click on the red arrow brings us to the Boiler dialog. The architect’s plans show a floor
space of 240 m2. As we need to define a heating boiler, but a calculation of the heating
requirement is not available, we can estimate the required power at 240 m2 * 5o W/m2 = 12 kW
and load a correspondingly sized heating oil boiler from the database (via the Se/ectbutton). We
leave the pre-set value for the boiler’s Nominal Output unchanged.

0il Boiler E

Parameters | Eff\c\encyl

[ Fized

M anufacturer I To50L Databass

Type: IDiI Boiler [ 12 k3w

Mominal Output: (12 ki

£ —Specific
|

Fieference: ID il Boiler

Mominal Output is dependent on the Hot “water and Space Heating Requirement.

Fuet
’7 Fuel Dil = ‘

Dperating Time:
Jan |Feb |Mar |&pr |May |Jun [Jul [Aug [Sep |Oct [Mov [Dec Cancel |
===

Operating Daps: 273 Days

Figure 5.3.6:
Dialog for the definition of the boiler.

As we want the solar system to provide hot water in summer without the use of a boiler, we click
on the months of June, July and August under Operating Times, (they change from green to white),
so that boiler operation is halted during these months.

We have now reached the end of the dialog chain and can exit the main dialog by clicking on OK.

5.3.3  Simulation

After entering the parameters for your solar system, you are now in a position to calculate the
system operating conditions over a period of a year by running a simulation. The simulation can
be started in two ways: either click on the Start Simulation button in the button bar (calculator
symbol) or via the main menu Calculations » Simulation (which will open the Simulation Period
dialog prior to simulation).

On the Simulation Period dialog, the Simulation Periodis pre-set at 1 whole year, and the results
Recording Intervalat 1 day. Both settings will suffice for our first simulation. 7he Pre-runof 3
days means that the simulation runs for 3 days before the first data is recorded (on 1 January).

Simulation, with the pre-set values, can be started direct by clicking on the Start Simulation
button in the button bar.

From the Simulation Period dialog, the simulation is started by clicking on OK. Once the
simulation has started you are able to click on the Viewbutton and observe the system’s
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temperature fluctuations. Click on the button again to return to fast mode and once the simulation
has been successfully completed, the following dialog will appear:

A ’
Cronte n Semsnry Aepon 7 g .‘3:. ErojectF |

Ie m Grophscal Evaleatios of the

Pssults rogeered ? .}1 E Gimphics |
Emllllln:Emnm ERcsancy m | E__"“ Ecornomic N oy |
Fasturs $0 Prograssss Scraes .}1 & Coes |

Simulstion Pesulls can also be evalustnd visthe menus FesuisiGmphics’ and
Pmen b Pricy & ot Pt

Simulstion Tme: D0:00:09

Figure 5.3.7:
Selection dialog at end of simulation.

5.3.4 Evaluation using Graphics Presentation

An initial evaluation of the system is always possible via the Project Report. If you create this
report, the first page will show a summary of the most important dimensions, the solar fraction
and the system efficiency. On this page we are also given the answer to the question of heating oil
savings: the solar system makes annual savings of approx. 400 litres of heating oil.

On the second page, the values for the basic parameters are given and on the third page there are
two graphics to assist in evaluation of the system.

The first graphic shows the course of the solar contribution over a period of 1 year in weekly
intervals. The second graphic shows the maximum temperatures that the collectors reach on
every day of the year. If you experience difficulties in printing these graphics with your printer,
you can produce the report in PDF format using Acrobat Reader® via the Options » Site Data »
Project Report menu. Once a report has been created it can be accessed via the Results » Project
Report menu.

In order to answer the question regarding daily storage tank temperature, click on the
T: Create Graphbutton or go to the Results » Graphics menu.
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Figure 5.3.8:
Selection dialog to produce a
results graph

| Cannd Caoval st 11

First of all, you select from the results that are available for each component listed in the project
tree in the left-hand section. With the Bivalent DHW Tank, information on the upper-tank
temperature is given if Sensor: Auxiliary Heating Onis selected.
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On clicking OK, a graph is produced plotting the mean monthly temperatures. Daily temperature
values can be set by double-clicking on the x-axis or, via the Axes » X-Axis menu.

Scale of X-Axis L x|

Dizplay Interval |1 I Marith j

Calurnn 4idth |1 I D ays j

Ciizplay from I 18
Figure 5.3.10:
ﬂl Sizing the x-axis for a daily temperatures graph

You can select the Display Intervaland the value for the Column Width here. With a setting of
Month, Days and Display from: 1.6, as illustrated above, the daily tank temperature is shown from
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15t June. You can change the display interval with the red arrow button and jump to the next
month.

The graph therefore gives the answer to the question of the number of days that the tank reaches
a temperature of 35 degrees. The evaluation is even simpler if you convert the graph into a table
via the Table menu.

A more precise measure of the temperature course can be gained if the temperature break-down is
shown in hourly intervals. However, in order to do this it is necessary to record the values in
hourly intervals during simulation. Go back to the Calculations » Simulation menu and set the
Recording Interval at 1 hour. Carry out a new simulation and then you will be able to study
temperature changes by the hour! To do this, select a Display Interval of 1 day for the x-axis.

Continue with this example and consider how the number of days can be reduced in which the
temperature falls below 35°C. Change individual parameters, such as storage tank size, tilt angle
and collector area! Run another simulation and evaluate the results.

Finally, the architect is asking you about additional building requirements. Recommend that hot
water connections for a washing machine and dishwasher be built into the system. With these
machines the hot water consumption is increased by 20-40 litres daily, which can be supplied by
the solar system, and therefore save valuable energy.
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6 MeteoSyn

6 MeteoSyn

With the MeteoSyn (meteorological synthesis) climate generator you can produce the hourly data

required to simulate a solar system in T*SOL from monthly mean values for radiation and

temperature.

You can open the four dialog windows in succession using the Continue and Back buttons, or you
can click on the corresponding icon in the navigation bar.

@ Start
=

é’%\ Location Data

l H Monthly Values
. Hourly Values

6_.1 Welcome

Welcame

&
&

Location Data

,

Monthly Yalues

Hourly Walues

With MeteoSyn yvou can use monthly values for radiation and temperatura to
generate the houtly walues required to run 8 T*SOL simulation:

The MeteoSyn database contains monthly mean values for approx. 2,000
locations worldwide. By simply entering the monthly mean values for any new
location, you can extend the database. If you do not know the monthly values far
a paricular location, you can go to the MASA website to obtain manthly walues
for radiation and temperature for additional locations. Select "Average
Insolation” and "Air Temperature At 10 m".

After lnading data for a location from the database or entafing the monthly rmean
values, the hourly walues for T*S0L are created and saved inthe Meteo folder of
the programme directory. I you then go back into T*S0L. you can load the
weathet file for the new location direct from the T*S0L load weather file dialogue
windoy.'

Back | | Continue || Cancel
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A detailed description of MeteoSyn and how it is used with T*SOL is given in the dialog window,
which also contains a link to a website where you can obtain additional weather data.

6.2 Location Data
S peteoSyn EJ@]EJ

4

'y ) . .
@ @ Define Mew Location Location from Database
Welcome Country I j

@ County / State |

Lacation Namel

Location Data )
Postal / Zip Code I
}:ﬁl HeightiD m

Lowest Qutside 17

Manthly ¥ alues Temperature 0,00 °C [ calculate
Temperature Rangs |9,00 g calculate
Longitude (East=-180 —Show Decimal Place in
T
West=+180) s & Degrees (00°00°-00°59')

Hourly Values
Latitude({South Pole=-20 Decimals (0,00-0,993

Morth Pole= 4903

Time ZonelD;D : i |

| Back | ; Cortinue i ! Cancel | | Help |

This is where you select the location you want to generate weather data for. You can:

e load a location from the database delivered with the program
e oryou can create a new location.

You are only able to save a location in hourly format for use in the MeteoSyn database if you select
Define New Location. If you select Location from Database, you will need to select the country
and location from the lists provided. The weather data record generated for T*SOL is then created
in either case in the Hourly Values dialog. The database delivered with the program contains
monthly values for approximately 2,000 locations worldwide.

Location names that appear in green are user-defined locations, which can be amended and
deleted.

You should always enter the county/state and postal/zip code, as these will be helpful when you
want to use the sort facility in T*SOL’s load weather data file dialog.

You will also need to enter the Lowest Outside Temperature. This value is required to calculate
the annual heating energy requirement. In Germany the DIN 4701 standard ambient temperature
should be entered. Otherwise the lowest daily average temperature, e.g. as used in sizing the
heating system.
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The Temperature Range is the Difference between the highest monthly average value for the
highest hourly daily temperature and the lowest monthly average value for the lowest hourly daily
temperature. The monthly mean values for the highest hourly daily temperature - or the monthly
mean values for the lowest hourly daily temperature - is calculated from the hourly temperature
values, where the lowest or highest hourly temperature is determined for each day and the
average for each month is then calculated.

Temperature Range =

Monthly max( j (Daily max (Tijx)) / (Days per month) )

Monthly min( ; (Daily min (Ti;«))/ (Days per month) )
with i as the hourly, j as the daily and k as the monthly running index.

ATime Zone is an area in the world where the same time is valid. Ideally, they run along the
degrees of longitude from the North/South Poles. For political reasons, however, the time zones
for many countries deviate from the ideal time zone. The actual time zone for the location needs to
be entered.

In MeteoSyn, time zones are counted from o westwards up to 23.
Greenwich Mean Time (GMT) = time zone o
Central European Time (CET) = time zone 23

Click on i (next to the Time Zone field) for a map showing the world’s time zones.
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6.3 Monthly Values

@ ol |51'mu|at|0nsy5tem INSEL |
Source

Feasured Period (Years)

“Welcome
I Krown Measured Peridd

@ Month Global Radiation [ /m=] |Mean edternal Temperature Lumeny L
Jan 526,0 1286 Country;

Location Data

= 56,0 77,8 AUSTRALIA
Lﬁ Mar 274,0 24,7 Country\State;

Rpr 245,0 18,7
Ma 198,0 15,3 :

Monthly Yalues ¥ 2 JTEA Location Mame:
L Le2 0 (122 | | ALICE SPRINGS
Jul 192,0 1,7
Bug 217,0 14,4

Hourly Values SE0 290 {1 | SaveData Record ‘
Dct 299,0 22,8 = —
May 305,0 25,8 | Sawe Data Becord ‘
Dec 309,0 27,8
Year 2585 |08 | | Datehsate lGscher ‘

| Back | | Contifue || Cancel |

The monthly values are shown here, if the locations come from a database.

If you want to define a New Weather Data you should enter the values here and then save the
location.

Only user-defined locations can be deleted or overwritten.

If you have selected Define New Location in the previous dialog window, you can enter the Data
Source in the input field provided. This entry then appears in the project report.

If known, you can enter the Measured Period (Years), which should be input in whole years. This
period is also shown in T*SOL’s load weather data file dialog and appears in the project report.

Monthly mean values should be entered in W/m2 under Global Radiation.

Continue to the Hourly dialog to create a T*SOL weather data record.
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6.4 Hourly Values

Welcome 26 | = 00
244
23 i
i - 20
Location Data U 1 4 I E
e 150 =
A0 o
mﬂ 5] 100
6 i LS
Manthly Yalugs 4 |50
.2_
0 e e e
2 4 & L 10 12
Howlo Wl i- External Temperature [ Global Radistion '
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| Back | | Caontifue || Close |

In this dialog you will need to save the weather location that you have created. When you confirm
by clicking on Save, hourly weather data is generated in file format with the ending .wbv, and this
is saved into T*SOL’s standard weather directory.

If you then go back into T*SOL, you can load the newly created weather file directly from T*SOL’s
load weather data file dialog.

This file, containing the hourly values required to carry out a simulation with T*SOL or PV*SOL,
remains permanently in the Meteo directory. The file appears in the Select Weather File dialog,
automatically under the country name that is selected in the MeteoSyn Location Data (5.2) dialog.
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7 Appendix

7.1 Heat Transfer Coefficient Overview

T*SOL Manual

This table matches the building construction and design types with heat transfer coefficient
values. The lower the U value, the less heat transmission losses are due, which make one part of

the heating demand.

=>» See for reference: 4.2 Enter Site Data

Construction Type Design type Insulation U value [W/K]
External Wall heavy high 0,22
External Wall heavy standard 0,39
External Wall heavy uninsulated 1,70
External Wall light high 0,13
External Wall light standard 0,17
External Wall light uninsulated 0,22
External Wall medium high 0,23
External Wall medium standard 0,43
External Wall medium uninsulated 3,05
Ground light/medium/heavy high 0,58
Ground light/medium/heavy standard 1,09
Ground light/medium/heavy uninsulated 8,42
Ground floor heating | light/medium/heavy high 0,30
Ground floor heating | light/medium/heavy standard 0,58
Ground floor heating | light/medium/heavy uninsulated 8,42
Roof heavy high 0,16
Roof heavy standard 0,24
Roof heavy uninsulated 4,32
Roof light/medium high 0,13
Roof light/medium standard 0,18
Roof light/medium uninsulated 3,16
Roof with cooling heavy high 0,16
Roof with cooling heavy standard 0,24
Roof with cooling heavy uninsulated 4,32
Roof with cooling light/medium high 0,13
Roof with cooling light/medium standard 0,18
Roof with cooling light/medium uninsulated 3,16
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7.2 Hot Water Demand Tables ASHRAE
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For more up-to-date information on usual hot water demand and many other consumption
references, see http://www.ashrae.org/ and the publications of the American Society of Heating,

Refrigerating and Air-Conditioning Engineers (ASHRAE).
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7.3 List of Adjustable Parameters
With reference to system Bs, swimming pool and combination tank system for hot water and

T*SOL Manual

heating
Components Parameters Default Value
System Item Variant ...
Ambient temperature 20 °C
Control DHW priority switching no
Savings Reference system no
Efficiency 78 %
Fuel Natural gas H
Climate File Berlin
Location Berlin
Hot water Consumption 1601/d
Target temperature hot water 50 °C
Cold water temperature February 8 °C
Cold water temperature August 12 °C
Profile Detached house evening peak
Circulation no
Circulation Simple length piping 10 m
Temperature difference 3 K
Specific losses 0,3 W/(m*K)
Operating times all days equally yes
Daily operating times 6-22 hours
Operating times Operating times DHW preparation 365d
Heat
Heat requirement Stan.dard building heat flow 6 KW
requirement
Heated effective area 130m?2
Inside room temperature 21 °C
Standard outdoor temperature -12 °C
Heating limit temperature 14 °C

Construction type

Medium-heavy building

External heating

Relation window area / gross floor area

N/O/S/W 2/5/10/7 %
Window type Double thermopane glazing
Inside external heating amount 5 W/m2

Heating Operating times August - May
Reduced times all days equally yes
Reduced times 23-6 hours
Reduction by 5 K
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Components

Parameters

7 Appendix

Default Value

Connection Collector
Loop

Collector loop

Heat transfer medium

Water-glycol mixture

Glycol share

40 %

Combination tank

Volume flow

40 |/h/m2 collector area

Collector loop pump on

8 K

Collector loop pump off

3 K

Swimming pool

Volume flow

40 |/h/m2 collector area

Collector loop pump on

8 K

Collector loop pump off 3 K
External heat transfer medium
Temperature difference 5 K

Control

Sequence of connections

1. Swimming pool
2. Combination tank

Collector Array Number of collectors 12
Orientation Orientation angle 30 °
Azimuth angle o °
Piping Simple pipe length
inside 8 m
outside 1 m
between collectors 200 mm/collector
Thermal conductivity of insulation
inside 0,045 W/(m*K)
outside 0,045 W/(m*K)
between collectors 0,045 W/(m*K)
Nominal size of piping
Manifold 18 mm
between collectors 15 mm
Thickness of insulation
inside 20 mm
outside 20 mm
between collectors 20 mm
Collector File Standard flat plate collector
1m?
Shading File none
Combination tank (int. heat
Storage Tank Type exchanger)
Volume 800 |
Number 1
Relation height / diameter 2
Insulation
Strength 100mm
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Components Parameters Default Value
Thermal conductivity 0,045 W/(m*K)
Control Target temperature rel. to DHW target 10
temperature
Auxiliary heating
Limited loading times no
Switch-on temperature -3 K
Switch-off temperature 3 K
Maximum temperature limit 90 °C
Switch on deflector valve 5 K

Auxiliary heating Type Gas condensing boiler
Rating 9 kw
Fuel Natural gas H
Operating times 365d
Efficiency Heating
Efficiency 91 %
with return temperature 60 °C
Efficiency 101 %
with return temperature 30 °C
DHW heating 70 %
Heating Loop high temperature heating Loop
Flow temperature 60 °C
Return temperature 40 °C
Low temperature heating Loop
Flow temperature 40 °C
Return temperature 25 °C
Percentage of HT loop o %

Swimming pool Type Open-air pool
Freshwater intake 83,33 l/d
Number of bathers 2 /d
Auxiliary heating no
Freshwater temperature February 8 °C
Freshwater temperature August 10 °C
Season 15.5. - 15.9.
Operating start 10 days earlier yes
Refill pool no

Pool Pool shape Rectangular

Length 8 m
Width 4 m
Average depth 2 m
Tile colour Light blue
Wind protection Partly available
Geographical environment open
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Components Parameters Default Value
Target temperature 22 °C
Max. swimming pool temperature 32 °C
Covering available no
Covering Eff. Swimming pool covering 90 %
Type of covering Shutters non-transparent
Covering times all days equally yes
Daily covering times 19-7 hours
Room climate Room temperature 25 °C
Rel. humidity 60 %
Solar yields Including energy input Complete
Considered up to 28 °C
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7.4 ITW System Layout

This solar system with combination storage tank for hot water and space heating is labelled
an ITW system layout. This means that this combination storage tank and, where available, its
controller have been measured and tested by the Institute for Thermodynamics and Heat
Engineering (ITW) at the University of Stuttgart.

In the T*SOL mathematical model, the system parameters have been adjusted by parameter
identifications such that the simulation results agree with the measurements.

The adjusted parameters in this system are therefore fixed and not changeable. In this system,
this concerns the entire storage tank, the control parameters of the collector array, and the
performance controller of the collector loop pump.

As a result of testing by the ITW and the subsequent validation procedure for the simulation, this
system holds the status of a "tested company system".

Manufacturer Test report no. Tested components

Broetje GmbH 04ST098 and 03CTR08 Combination storage tank and
matching controller

BBT Thermotechnik (Buderus) | 04STO98 and 03CTR08 Combination storage tank and
matching controller

Feuron GmbH 03ST094 Combination tank

Ratiotherm GmbH 0357091 Combination storage tank and
matching controller

Teufel und Schwarz GmbH 02ST083, 02CTRo7, and Combination storage tank and

03CTRo9 matching controller
Wagner Co. GmbH 03 STO88 and 03CTR11 Combination storage tank and

matching controller

Max Weishaupt GmbH 04STO97 Combination storage tank and
matching controller
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7.5 Company Systems

7.5.1  Solahart Systems

These system types are exclusively offered by Solahart. They comprise thermosyphon systems
with optional downstream flow heater. Further information can be obtained from
www.solahart.com.

7.5.2  Viessmann Systems
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These system types are exclusively offered by Viessmann. Viessmann collectors, storage tanks,
and condensing boilers can be individually selected. Further information can be obtained from
www.viessmann.com.

7.5.3 Wagner Systems

Wagner&Co

SOLARTECHNIR

Wagner & Co

SOLARTECHKIK

ner& Co
SOLAHTECHNIK

Wagner& Co
RTFCRMIR

———Wagner & Co

e DL LAN T EC IR K

These system types are exclusively offered by Wagner Solartechnik. Wagner collectors, storage
tanks, and condensing boilers can be individually selected. Further information can be obtained
from www.wagner-solartechnik.de.
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These system types are exclusively offered by Beretta Sylber und Vokera. The company's
collectors, storage tanks, and condensing boilers can be individually selected. Further

information can be obtained from the company's websites: www.sylber.it, www.berettaclima.it
and www.vokera.co.uk.
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7.5.5  Riello and Thermital Systems
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These system types are exclusively offered by Riello and Thermital. The company's collectors,
storage tanks, and condensing boilers can be individually selected. Further information can be

obtained from the company's websites: www.riello.com and www.thermital.it.
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These system types are exclusively offered by Riello and Thermital. The company's collectors,
storage tanks, and condensing boilers can be individually selected. Further information can be
obtained from the company's websites: www.riello.com and www.thermital.it.
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7.5.6  Vaillant Systems

M Vaillant EVaillant

Vaillant A1 Vaillant A2

A B Vaillant

EVaillant

Vaillant Bs.2

These system types are exclusively offered by Vaillant. Vaillant collectors, storage tanks, and
condensing boilers can be individually selected. Further information can be obtained from
www.vaillant.de.
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7.6 Glossary

Active solar surface, m2
The specific collector parameters are not usually related to the gross surface area but to the
active solar surface, derived from the testing centre reports. Depending on the testing centre,
the active solar surface of flat plate collectors is either the absorber area or the - aperture
area. With evacuated tube collectors (e.g. with mirror constructions and vertically-standing
absorbers), the active solar surface is often a purely theoretical value.

Annual heating requirement, Qxn

[kWh/a]
The total heat which must be supplied to the rooms of a building within one year to maintain a
target temperature (building energy).

Annuity, A
A series of equal payments, allowing for - lifetime and interest rate, for repayment of a

capital debt. It is the product of annuity factor and investment sum.

Anti-Legionnaire's switch, LEG
The guidelines of the German Association for Gas and Water specify that the entire content of
the storage tanks and the piping in systems with a drinking water storage tank size of 400
liters and domestic hot water pipe content of over 3 liters must be heated to 60° once a day.
The hot water storage tank is loaded in adjustable intervals in systems with an anti-
Legionnaire's switch.

Aperture, Aa(m?)
Largest projected area through which unconcentrated solar irradiation enters the collector. In
flat plate collectors, the area of the collector covering through which solar irradiation can
penetrate the inside of the collector housing (light penetration area). In evacuated tube
collectors, the aperture is the product of the length and width of the absorber strip and the
number of tubes. If evacuated tube collectors are fitted with a reflector (- CPC), the aperture
is equal to the product of the length and width of the mirror surface

Auxiliary heating, AuxH
Ensures that the -+ target temperature is reached even when there is insufficient irradiation.
Where applicable, it also supplies the heating loop. Usually refers to the boiler.

Balance, (B)
..... + Energy balance

Balancing,

Base load, [W, kW]
Minimum load / output an energy supply system must make available constantly during a
period of use.

Boiler, Boil
Serves to convert chemical energy into heat.
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Boiler efficiency, n [-]
The boiler efficiency describes the relationship between the energy used by the boiler and the
energy produced over a specific period of time.

Buffer tank, PSP
A storage tank filled with domestic hot water, usually in steel. The heat is transferred either
internally via a serpentine pipe or outside the tank by means of an external heat transfer
medium.

Building energy requirement, Qs [kWh/a]
Generic term for heating requirements, cooling requirements, energy requirements for hot
drinking water, lighting, humidification.

Calculation of pollutants
The solar system's CO2 emissions savings are calculated. This is based on the emissions
factors of the fossil fuel under consideration for heat generation. The emissions factors used

here depend on the (saved) fuel. (- fuel savings) -+ CO2 emissions

Capital value, Vo

Sum of all --* cash values of investments, subsidies, savings, operating costs, and loan costs

(each signed). The interest rate used is equal to that which would apply when borrowing
capital for the investment from a bank or at which the capital used could yield interest.

Cash value, [€]
Discounted future payments at the start of the period under consideration. A cash value is
positive if it can be recorded as revenue and negative if the amounts represent costs. Items
calculated are investments, subsidies, savings, and operating costs. - capital value

Circulation, Circ
Circulation can be used for hot water preparation. This increases comfort (hot water is
immediately available, even with long piping systems), but is also coupled with losses.
Appendix user guide T*SOL 154 Dr. Valentin EnergieSoftware GmbH.

Climate, C
Climate is the current atmospheric conditions or a sequence of atmospheric conditions at a
specific place which run their course over a specific period of time.

Climate data
The climate data supplied with the program (for numerous locations) contains hourly median
values for global radiation, outdoor temperature, and wind speed.

CO2 emissions, [g, kg]
(Carbon dioxide) is the quantitively most significant greenhouse gas (GHG) released by
human activity (in particular combustion of fossil fuels). - Calculation of pollutants

Collector, Coll
Technical device for converting radiation energy into heat energy. Common types are flat plate
and evacuated tube collectors.

Collector array, CA
The collector array consists of the collectors and the piping.

Collector loop, CL
Circuit containing the -+ collector or the % absorber and which is responsible for

transporting heat from the collectors to the storage tank or heat transfer medium.
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Collector loop connection
The collector loop connection represents the connection between the - collector array and
the storage tank by flow and return.

Collector loop efficiency
Quotient of the energy emitted from the collector loop and the energy irradiated onto the
collector area (active solar surface)

Compound parabolic concentrator, CPC
Compound parabolic concentrator, reflectors used in evacuated-tube collectors for
enlargement of the -+ aperture area in a geometrically optimized form as a parabolic trough.

Controller
The controller has the responsibility of ensuring optimal operation of the system. Control
parameters can be set for various components. For storage tanks, for example, target
temperatures, switching temperatures.

Cooled

Costs
Consumption of goods to create and sell services and other goods.

Daily consumption, [l]
The average daily domestic hot water consumption. This is usually 35-45 liters per person and
day at a water temperature of 50°.

Declared value for thermal conductivity, A [W/(mK)]
Value of the - thermal conductivity of a construction material or product under specific
external and internal conditions which can be considered typical of the behavior of this
product when installed in a component.

Site Data, Def.

Design temperature, °C
Temperature determined by the relevant climate zone as per DIN EN 12831 supplement 1 table
1a. The design temperature is the maximum (necessary) temperature of the heating water
which suffices at the lowest winter temperature for the heating system to provide the building
with required amounts of heat.

Deverter / injection system
Special version of a control circuit. Particularly useful when the user is far away from the
output but if required needs hot water promptly (often RLT)

DHW consumption, DHW con

DHW requirement
..... * Daily consumption

Diffuse radiation, Gairr [W/m?2]
Part of solar irradiation which strikes a horizontal or tilted surface via scattering through air
molecules and mist particles or reflection on clouds.
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DINV 18599
"Energy efficiency of buildings, calculation of net, final, and primary energy requirements for
heating, cooling, ventilation, domestic hot water, and lighting" Basis of calculation for the
EnEV 2009 certifications for residential and non-residential buildings

Direct radiation, Gair [W/m?2]
Part of solar irradiation which strikes a horizontal or tilted surface without changing direction.

District heating, DistHeat
Heat supply for heating buildings and drinking water. In district heating, waste heat created
during power generation (cogeneration) is used, among others. Transfer of heat is
predominantly effected via underground piping.

DKE, DKE
German Commission for Electrical, Electronic & Information Technologies of DIN and VDE.
Organization in Germany responsible for creating standards and safety regulations in the field
of electrical engineering, electronics, and information technology.

Domestic hot water, WW
Domestic hot water typically refers to warm drinking water and in contrast to heating or buffer
tank water can be consumed.

Efficiency, Eff

The -+ collector loop efficiency and the - system efficiency are calculated.

Electric heating element, el HE
Electrical auxiliary heating in the storage tank

Electrical power, Pe [W, kW]
The electrical power states how much electrical energy is used in a specific unit of time.

Energy, E (Joule)
Energy is the ability to perform work. The forms of energy are divided into mechanical energy
(kinetic and potential energy), thermal, electrical and chemical energy, radiation energy, and
nuclear energy.

Energy balance
Comparison of incoming and outgoing energy flows in a system: the sum of energy supplied,
energy released, and the storage of energy by the heat capacity of the system components
must be equal to zero. Balancing is not carried out wholesale for the entire system but for the
individual system components.

Energy balance scheme
----- + Sankey graph

Energy input, E, Qz« [Wh, kWh]

Energy supplied to a component, e.g. irradiation, heat supply at the heat exchanger or heat
transfer by mass flow due to consumption or circulation.

Energy output, Qas [Wh, kWh]
Energy (heat) transferred from one component (collector loop, storage tank etc.) to another
component or the environment.

Energy produced by solar system, Qab [Wh, kWh]
Comprises the energy transferred to the standby tank from the solar tank due to consumption
and any existing return circulation control in the solar tank.
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Energy supply

..... » Energy input

External financing
Part of the capital commitment is covered not by personal capital but by taking out loans. If
the loan interest is higher than the capital interest, borrowing incurs further costs.

Final energy requirement, Qe [kWh/m2a]
Calculated amount of energy available to the system technology (heating system, ventilation
and air-conditioning system, hot water heating system, light system) to ensure the set inside
temperature, heating of warm water, and desired lighting quality over the whole year. This
amount of energy includes the auxiliary power required to operate the system technology. The
final energy is transferred at the "interface" of the building's external envelope and thus
represents the amount of energy required by the user for use as intended under normative
boundary conditions. The final energy consumption is therefore stated by energy sources
used.

Flow, FL
Flow generally denotes the warmer string in a heat loop. In a solar loop, flow corresponds to
the pipe from the collector to the storage tank.

Fresh water requirement
here: the domestic water supplied to the swimming pool for filling.

Fresh water station
Hygienic domestic hot water heating with the help of a plate heat exchanger in a continuous
flow process, compact station with heat exchanger, pump, controller.

Fuel consumption
The calculation of fuel use (natural gas, oil, wood pellets, district heating) is derived from the
energy transferred to the auxiliary heating heat exchanger via the fuel's heat equivalent and
the auxiliary heating efficiency.

Fuel price, [€/kWh]
The price for the stated final energy valid at the time of calculation. It must be entered in the
currency given in Windows' country settings.

Fuel saving, [€/a]
Fuels are primarily used to generate heat. In addition to reducing heat loss, the use of solar
heat generates fuel savings. The program converts the available solar heat at any one time,
using the respective auxiliary heating efficiency and the corresponding heat equivalent of the
energy source, into fuel savings.

Global irradiance, G (W/m?2)
Hemispherical irradiation onto a horizontal surface.

Gross collector area, Ac (m?)
Surface area of the collector excluding devices for attachment and the piping connection.
Usually width by length. Calculated by the external dimensions of the collector; the specific

collector parameters are not usually taken from the gross area but from the -+ active solar
surface.

Heat consumption, Hcon
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Heat exchanger, HE
Heat exchangers are used when heat is to be transferred between different heat transfer
media. Internal and external heat exchangers are differentiated.

Heat gains, Qs, Qi
Comprise the solar heat gains (dependent on the window area, type of window, and
inclination) and the internal heat gains (e.g. produced by electrical appliances).

Heat load, & [W, kW]

Heat loss rate, [W/K]
Product of heat transfer coefficient and the surface of the heat exchanger. The value is equal
to the quotient from transferred power and median logarithmic temperature difference at the
heat exchanger.

Heat losses
Thermal losses occur through piping, radiation, and convection of heat in a collector. With
selective absorber coatings, good thermal insulation or a vacuum, thermal losses can
potentially be kept as low possible.

Heat requirement, Qn [kWh]
The heating capacity required to maintain a target room temperature in a building (net

energy).
Heat requirement, HR

Heat transfer coefficient, U [W/(m2K)]
The heat transfer coefficient of a component describes the heat flow (heat lost) on a
temperature difference of one Kelvin per square meter of the component. This is the crucial
heat insulation property of outdoor components. The smaller the heat transfer coefficient, the
better its insulation efficiency.

Heat transfer coefficient (heat loss coefficient) of the collector, k: [W/(m2K)], k2 [W/(m2K2)]
States how much heat the collector releases to its environment per square meter of active
solar surface and temperature difference in Kelvin between the collector median temperature
and the environment. It is split into two parts, the simple and the quadratic part. The simple
part (in W/mz2/K) is multiplied by the simple temperature difference, the quadratic (in
W/m2/K2) by its square. This results in the typically stated efficiency parabolic curves.

Heat transformer
..... + Heat exchanger

Heating cost
Calculated from the quotients of - investment, - operating costs, and the heat generated

(taking into consideration - lifetime and - capital interest).

Heating flow, Q dot, @, [W]
Represents a quantitative description of heat transfer processes. The heating flow is an
amount of heat (heat output) transferred in a given time; direction of flow always from area of
higher temperature to area of lower temperature.
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Heating loop, HL
A self-contained system for distributing heat from the heat generator to the user, flow and
return flow temperatures are dependent, among others, on the transfer system to rooms to be
heated. Two heating loops with different design temperatures can be defined in T*SOL, a high
temperature heating loop for radiators and a low temperature LT heating loop for underfloor
heating.

Heating network, HN
Concentration of heating requirements in heating output units of varying size in the form of
district or local heating networks.

Heating temperature limit, The
Minimum / maximum outdoor temperatures at which the heating is switched on or off. The
heating temperature limit is dependent on the insulation class of the building.

High temperature circuit
A heating loop with high flow and return temperatures, e.g. for use in radiators and similar.

Incident angle modifiers, Kq
Describe the reflection losses when the sun is not perpendicular to the collector area.

Installation
The installation of the collector array is determined by the - tilt angle and the - orientation

angle (azimuth). From the tilt angle and orientation angle, the - radiation processor

calculates the irradiation on the tilted surface for a specific location.

Investment
Typically long-term, targeted capital commitment to generate future yields. Investment costs
here correspond to the system costs, less any subsidies.

Irradiation model
The values saved in the --* climate data for global radiation are divided into diffuse and direct
parts according to the Reindl model.

Irradiation processor
Calculates irradiation on the tilted area from the - installation and -+ orientation angle of

the collector array, taking into consideration the diffuse and direct parts.

Life (of loan)
Period of time agreed for repayment of a loan.

Lifetime
The period of time stated by the manufacturer in which the system should remain operable.

Load profile, [W, kW] [%]
Hot water consumption dependent on time. The calculation is based on the definition of
different daily, weekly and annual profiles.

Loading loop, LL
----- 3 Storage charging loop

Loading time, [h]
Describes the period required for the storage tank to be loaded fully (supply of energy).

Loan capital
The amount of the loan taken out. It bears interest and must be repayed.
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Loan interest
The amount of interest that has to be paid on a loan. If the loan interest rate is lower than the
capital interest rate, borrowing a loan results in income from interest.

Local heating, LH
Local heating describes the transfer of heat between buildings over relatively short distances
in comparison with district heating.

Low temperature circuit
Heating loop with low flow and return temperature, e.g. for use with underfloor heating

MeteoSyn
Program for generating climate data.

Nominal size, [-]

[mm]
States the diameter of a pipe. DIN nominal piping sizes are used to calculate the collector
loop piping widths. The term DN (diameter nominal) states the internal diameter. With copper
piping, the outer diameter and the wall thickness of the material are stated.

Off, off
Switch in a program dialogue box.

On, on
Switch in a program dialogue box.

Operating costs, [€/a]
Costs arising from operation of the system, e.g. maintenance costs, electricity costs. The -3
cash value and the - annuity of the operating costs are derived from the - capital interest,

----- + rate of price increase, and the - lifetime.

Operating period, (h)
Each respective component is active during the operating period. A component is not active
during the specific time periods (hours, days or months) that have been switched off.

Orientation angle, a. (°)
(azimuth) Describes the angle of deviation of the collector area from the south in the northern
hemisphere. It is 0° when the surface is facing due south. The azimuth is positive when facing
west and negative when facing east. An orientation due west corresponds to a value of +90°
and an orientation due east is -90°.

Pay-back time, Period of time required until the total of returns on an investment (static
payback method) or its - capital value (dynamic payback method) reaches the amount of the
investment. Here: the period of time the system must operate for the investment to yield a
capital value of zero. The program does not calculate pay-back times of over 30 year.

Primary, Pr

Primary energy requirement, Qo [kWh/a] [kWh/(m2a)]
Calculated amount of energy which, in addition to energy content of the required fuel and the
auxiliary power for the system technology, also includes amount of energy resulting from
upstream process chains outside the building in extracting, converting, and distributing the
respectively used fuels. - available in table form.
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Primary loop
Heating loop in the heat generator with high temperatures for transferring heat with a heat

transfer medium to the --* secondary loop.

Process heating, PH
Process heating is the heating required for a large number of technical processes and
procedures (drying, cooking, melting, forging etc.). The process heating must typically be
generated by combustion processes or electric current, can however in the best case be
recovered in part as waste heat.

Proportional energy saving
as DIN EN 12976

Rate of price increase, [%]
The prices for non-renewable energy sources are rising as a result of growing demand and
increasingly scarce supplies. The development of operating costs and energy consumption
play a crucial role in calculating the capital values of investments. Appendix user guide T*SOL
152 Dr. Valentin EnergieSoftware GmbH.

Redirection valve, RV
~~~~~ + Three-way valve

Return, R
The return commonly describes the cooler string in a heating loop. In a solar loop, the return
is the pipe from the storage tank to the collector.

Sankey graph
Graphic representation of energy or material flows using arrows, in which the width of the
arrows is proportional to the width of the flow.

Savings
The simulation results include the reference fuel savings made during the simulation period
through the use of the solar system.

Secondary loop
Heat consumer

Secondary loop
Contains the medium to be warmed, is heated by the - primary loop.

Simulation
Test of the influence of ambient conditions, user behavior, and the various components on the
operating conditions of the solar system with the help of computer calculations

Simulation period
Total period of time for which the simulation is to run. Simulation periods of between one day
and one year are possible

Simulation range
Time interval between two successive calculation steps. It varies between 1 and 6 minutes
depending on the system and is set automatically.

Solar azimuth, as
Deviation of the respective position of the sun from the south, constantly changes as a result
of changes in the sun's position, is 0° at 12.00 p.m. CET
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Solar cooling, SC
With the help of heat generated solar thermically, solar cooling is used to generate cooling or
open sorption-based air-conditioning in a closed absorption or adsorption process.

Solar fraction, SolFr, f
The proportion of energy transmitted by the solar system to the standby tank to the total
amount of energy transmitted to the standby tank (from the solar system and auxiliary
heating).

Solar heat
Solar heat describes the conversion of solar energy into available heating energy.

Solar storage tank
The solar tank is the storage tank or part of a tank that is loaded from the collector array.

Solar yield, (kWh/m?)
Energy released by the collector loop within a specific period of time.

Space heating, Heat
All technical elements and systems which serve to generate, store, distribute, and transfer
heat.

Specific heat capacity
The amount of heat per m2 of active solar surface that the collector, including its heat transfer
medium content, can store at a temperature increase of 1 Kelvin. Benutzerhandbuch T*SOL
Anhang Dr. Valentin EnergieSoftware GmbH 153

SRCC
Solar Rating and Certification Corporation - USA

Standard heat load, &u. [W, kW]
Standard DIN EN 12831 (August 2003) describes the calculating procedure to determine the
output of the heat generator and the heating surfaces required under normal design
conditions to ensure that the required standard indoor temperature is reached in the rooms
used in the building.

Standard heat requirement, Qn,cen (W; kW]
Former term for heating load
The standard heat requirement is the basis for the dimensioning of the heat generator (boiler,
solar system ...). It states the required heating output to maintain the desired indoor
temperatures (e.g. 20°C) in all rooms at the design outdoor temperature.

Standard outdoor temperature, ®.

[°cl
Outdoor air temperature used to calculated standard heat loss. It represents the lowest two-
day median the air temperature has reached or dropped below 10 times in 20 years.

Standby storage tank,
A system storage tank which is used exclusively for storing domestic hot water pre-heated to
the target temperature (e.g. System A2).

Storage charging loop,
Pump circuit for charging the storage tank - storage charging system
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Storage charging system,
Storage tank heating from bottom to top by means of a charging pump (storage charging
loop), the heating surface can be located inside or outside the storage tank.

Storage model,
Representation of loading and unloading processes
The stratified storage model uses storage layers of variable strength. The number of layers in
not fixed but adjusted during simulation.

Storage regrouping
Heat transport from the solar storage tank to the standby tank. When activated, storage
regrouping occurs when a higher temperature is present in the solar storage tank (top) than in
the standby tank (top).

Storage tank, ST
To bridge weather-related and/or seasonal fluctuations in irradiation, storage tanks are used
to buffer heat. The volume of the storage tanks is governed by the heating requirement and
the period of time to be bridged.

Stratification
Facility enabling layered loading of storage tanks. Typical stratifications are e.g. convection
chimneys with radial openings.

Sun height, angle of elevation, ys
Angle of the sun to the horizontal

Suneye
Device to determine an optimal location for the solar system with the help of annual
irradiation graphs and sun-active time of day data.

Supplementary heating

----- » Auxiliary heating

Supply/removal, (on/off)

Swimming pool, SP

Swimming pool water heat requirement
The total amount of energy generated by the solar system and auxiliary heating for the
swimming pool.

System efficiency
Quotient of the available energy generated by the solar system and the energy irradiated onto
the collector surface (active solar surface). It is a benchmark for the system's efficiency.

Target temperature
The minimum temperature of domestic hot water If the target temperature in the upper layer
of the tank is not reached, the -+ auxiliary heating is switched on.

Target value, Targ

Temperature, T (°C)
The temperature is a material property and describes the ability of a body to generate internal
energy in the form of heat.
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Thermal buffer store, Contains heating water for heat storage.

Thermal conductivity, A [W/(mK)]
The thermal conductivity states the amount of heat passing through one square meter of a 1m-
thick layer of building material in an hour when the temperature difference between the two
surfaces is 1 Kelvin.
Criterion for assessing the quality of insulating material.

Thermal engineering
Thermal engineering describes all aspects of energy conversion, storage, and transferin
machines and apparatus with the exception of electrical energy.

Thermal equivalent
Conversion process making energy sources comparable by their heat content (heating value).

Thermosyphon system
Operation in a closed circuit according to the gravity filtration principle without the use of
pumps or controls.

Tilt angle, B (°)
(inclination) Describes the angle between the horizontal and the collector surface. This is 0°
when the collectors are flat on the ground and 90° when they are vertical.

Value for the energy requirements of a system, er

[-]
The value for the energy requirements of a system describes the ratio of primary energy
absorbed by the system technology in relation to the available heat released by it. The smaller
the value, the more efficient the system. In residential buildings, the value for the energy
requirements of a system also takes account of preparation of a standard amount of hot
water.

VDE
(German) Association for Electrical, Electronic & Information Technologies

Volumetric flow rate, Vp- Flow, [l/h], [|/m2h]
The movement of a volume of a medium in a unit of time through the cross-section of a tube.
The volumetric flow rate for the collector array is stated in |/h and can be specified either
absolutely or relative to the collector area.

Zero-loss collector efficiency, no
States the proportion of radiated energy absorbed by the collector on vertical incidence when
the median temperature of the heat transfer medium in the collector is equal to the ambient
air temperature.
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